


Some of the figures in this presentation are taken from "An Introduction to Statistical Learning, with
applications in R" (Springer, 2013) with permission from the authors: G. James, D. Witten, T. Hastie
and R. Tibshirani
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e Whatis it?
e What can it do¢ (use cases)
« How does it work?
« JIMP Mechanics
e Interpret results (statistically)
e Interpret results (application)
« How to apply the results
« How to understand the managerial
implications
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WHAT IS IT?




Y X Objective Summary of Statistical Operational | Mgt Insights
Fit Significance | Significance
Measures Measure

Continuous Continuous or Explanatory RSquare Adj, Prob >F Mean and Profiler;
Categorical Root Mean (p-value) Individual Variable

Square Error Confidence Importance
Limits
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WHAT CAN IT DO< (USE CASES)




 |s there a relationship between advertising budget and
salese

* |s there a relationship between sales and pricee

« Explaining customer spending based on demographic
information and historical buying patterns

» Developing pricing strategies based on product mix and
consumer characteristics

» Establishing housing prices
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HOW DOES IT WORK?




Figure 3.4, An Introduction to Statistical Learning by James, et al, (Springer 2013)
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— Mulfiple Regression

Least Squares
Regression:

Fit fOo minimize the sum of
squared residuals

e’ t+tej’+...ter?
wheree =y -V




When fitting a least squares line, we generally require

Linearity. The data should show a linear trend. If there is a nonlinear trend (e.g. left

panel of Figure 7.13), an advanced regression method from another book or later

course should be applied.

Nearly normal residuals. Generally the residuals must be nearly normal. When this
condition is found to be unreasonable, it is usually because ol outliers or concerns
about influential points, which we will discuss in greater depth in Section 7.3. An
example of non-normal residuals is shown in the second panel of Figure 7.13.

Constant variability. The variability of points around the least squares line remains
roughly constant. An example of non-constant variability is shown in the third panel
of Figure 7.13.

Be cautious about applying regression to data collected sequentially in what is called a
time series. Such data may have an underlying structure that should be considered in
a model and analysis. There are other instances where correlations within the data are
important. This topic will be further discussed in Chapter 8.

Chapter 7, Introduction to Linear Regression, Openlintro.org
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Figure 7.13: Four examples showing when the methods in this chapter are

insufficient to apply to the data. In the left panel, a straight line does not
fit the data. In the second panel, there are outliers; two points on the left
are relatively distant from the rest of the data, and one of these points

is very far away [rom the line. In the third panel, the variability of the
data around the line increases with larger values of z. In the last panel,
a time series data set is shown, where successive observations are highly
correlated.

Chapter 7, Introduction to Linear Regression, Openintro.org
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JMP MECHANICS




jmp.com/flearn rev 02/2014

Multiple Linear Regression

i Multiple linear regression is used to model the relationship between a continuous response variable and

continuous or categorical explanatory variables.

Multiple Linear Regression Using Fit Model

From an open JMP® data table, select Analyze > Fit
Model.

Click on a continuous variable from Select Columns, and

click ¥ (continuous variables have blue triangles).
Choose explanatory variables from Select Columns, and
click Add.

Click Run Model.

By default, IMP will provide the following results:

Actual by Predicted Plot.
Summary of Fit table.
Analysis of Variance table.

Parameter Estimates table, and more (not shown).

JMP also provides Leverage Plots for each explanatory
variable in the model, and for nominal and ordinal

Multiple Regression | Jim Grayson, PhD variables, the least squares means tables.




= Example: Big Class.jmp (Help = Sample Data)

= Fit Model IR = | 2 |t
= Mode| Specification
telprt Celiimins Firk Kok wamanes P '=“|-:I'- Ctmncare Los=t Squares v
iiame seichi —
| jh“:"'-ll CIMEEEST | Effec] Leyerage ¥
agr
"E'ef': [ Weeighit
dihy=ight e -
Ayt | Freg
bacall Ke=p tialog open
| By
Blamosns

[  ada ayE
ECtE
Cross i
| = hieight
heighs*age
[ hest H

| kMacros =

Degres EI
Afrbutas =
Transiorm (=

Mo Intercept
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Tips:

To add interactions terms: In the Fit Model Specification
window, select the variables under Select Columns and
click Cross. The term age*height in the first figure is a two-
way interaction. Higher-order terms can also be added.

To save the prediction formula, predicted values, residuals
or other values to the data table, click on the top red
triangle, select Save Columns.

IMP will create new columns in the data table.

To view indicator parameterization (using 0, 1 coding),
select Estimates > Indicator Parameterization Estimates
from the top red triangle.
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R

4 = Response weight
AWhole Model
4 Actual by Predicted Plot
180
L ]

- 160+

g 140 -.." >

= .l o & e

E 100 .'?.i.

- BI:-]_. ".' L ]
g0+

| I | I
60 80 100 120 140 160 180
weight Predicted P<.0001
RSq=0.74 RMSE=13.645

4 Summary of Fit

RSquare 0.738499
RSquare Ad) 0822276
Root Mean Sqguare Error 13.64511
Mean of Response 105
Obsenvations (or Sum Wgts) 40
4 Analysis of Variance
Sum of
Source DF Sguares Mean Square F Ratio
Model 12 14196.898 1183.07 B6.3542
Error 27 5027 102 186.19 Prob>F
C. Total 39 19224 000 = 0001*
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= Prediction Profiler

To view the effect of an explanatory variable on the 180

predicted response, click on the top red triangle, select 1404

- . i,,:;’lms.a::se. 1k
Factor Profiling and choose Profiler. — | %3660y 1004

In the Prediction Profiler, click and drag the vertical red
line for a variable to change the level or value. The
predicted mean response and Cl are displayed.

Note: For more details on regression analysis, see the book Fitting Linear Models (under Help > Books) or
search for "regression” in the JMP Help.
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HOUSING PRICES EXAMPLE

Dataset: HousingPrices. mp




e —
A real estate company that manages properties around a ski resort in the United States

wishes to improve its method for pricing homes. Sample data is obtained on a number of
measures, including size of the home and property, location, age of the house, and a strength-
of-market indicator.

The Data HousingPrices.jmp

The data set contains information on about 45 residential properties near a popular North
American ski resort sold during a recent 12-month period, and is a representative sample of

the full set of properties sold during that time period. The variables in the data set are:

Price: Selling price of the property (in thousands of dollars)

Beds: Number of bedrooms in the house

Baths: Number of bathrooms in the house

Square Feet: Size of the house in square feet

Miles to Resort: Miles from the property to the downtown resort area

Miles to Base: Miles from the property to the base of the skiresort’'s facing
mountain

Acres: Lot size in number of acres
Cars: Number of cars that will fit into the garage
Years Old: Age of the house at the time it was listed in years

DoM: Number of days the house was on the market before it was sold
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|

State modeling objective ‘ ‘ Multiple Regression Modeling Process

Data gathering and preparation ‘

Explore univariate | bivariate | multivariate relationships
‘ for data quality and to inform understanding

—

Data exploration

* ‘ ‘ * Transform y | Re-form model

. Model Fit Model (guadratic, interaction terms,)

Check assumptions and conditions:

) . Residual v. predicted; actual v. predicted: == i
independence, equal variance, normal P : P Use stepwise as needed | Remove

studentized residuals; normal plot; influential point | re-fit model

Check high influence points, outliers Cook's D; VIF

and multicollinearity

State and test hypotheses about Analysis of variance; parameter estimate;
multiple regression coefficients Model reduction (stepwise; manual)

Interpret regression statistics - whole
model results: adj R"2, overall p-value;
RMSE

Interpret signs of regression
coefficients

Assess usefulness of model (s,
prediction intervals; profiler; variable
importance)

Apply to stated model objective

© Jim Grayson & Mia Stephens
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State modeling objective Multiple Regression Modeling Process

Data gathering and preparation

Explore univariate | bivariate | multivariate relationships
for data guality and to inform understanding

Data exploration

* Transform y | Re-form model

Model Fit Model (quadratic, interaction terms,)

Check assumptions and conditions:

. . Residual v. predicted; actual v. predicted: e -
independence, equal variance, normal P ! P Use stepwise as needed | Remove

studentized residuals; normal plot; influential point | re-fit model

Check high influence points, outliers

. , Cook's D; VIF
and multicollinearity

© Jim Grayson & Mia Stephens
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State and test hypotheses about Analysis of variance; parameter estimate;
multiple regression coefficients Model reduction (stepwise; manual)

Interpret regression statistics - whole
model results: adj R"2, overall p-value;
RMSE

Interpret signs of regression
coefficients

Assess usefulness of model (s,
prediction intervals; profiler; variable
importance)

Apply to stated model objective

© Jim Grayson & Mia Stephens
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‘ Multiple Regression Modeling Process

State modeling objective

Data gathering and preparation

Explore univariate | bivariate | multivariate relationships
for data quality and to inform understanding

Data exploration

Model . * Transform y | Re-form model
Fit Model (quadratic, interaction terms,)

Check assumptions and conditions: Residual dicted tual dicted

. . esidual v. predicted; actual v. predicte £ i

independence, equal variance, normal p ’ p ¥ Use stepwise as ne_EdEd | Remove
influential point | re-fit model

Check high infl int i
ec ‘?? |n. uen_ce points, outiiers Cook’s D; studentized residuals; normal plot; VIF
and multicollinearity

State and test hypotheses about Analysis of variance; parameter estimate;
multiple regression coefficients Model reduction (stepwise; manual)

Interpret regression statistics (whole
model results: adj R"2, overall p-value;
Cp; RMSE

Interpret signs of regression
coefficients

Assess usefulness of model (s,,
prediction intervals; validate it works

Apply to stated model objective

© Jim Grayson & Mia Stephens
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| Select Columns
*'10 Columns

APprice
dBeds
AR aths
l5quare Feet
AMiles to Resort
dMiles to Base
i cres
ACars
dlears Old
ADoM

Pick Bolelariah

| Weight |

| Freq |

| Validation|

| By |

£S5

bdodel Effects

B ath:

| Macros = |

Degree
Attributes =

Transform =
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Mo Intercept

| Sguare Feet
Miles to Resort
Miles to Baze
Acres

Cars

Years Old
Do

-

Persof{ality: | Standard Least Squares

Emphasis: ectleverage

| Recall | Keep dialog open
| Remove |




ko

State modeling objective

Data gathering and preparation

Data exploration

Multiple Regression Modeling Process

Explore univariate | bivariate | multivariate relationships

for data guality and to inform understanding

Check assumptions and conditions:
independence, equal variance, normal

F oot

Residual v. predicted; actual v. predicted:

studentized residuals; normal plot;

Check high influence points, outliers
and multicollinearity

Multiple Regression | Jim Grayson, PhD

Cook's D; VIF

* Transform y | Re-form model
(guadratic, interaction terms,)

** Use stepwise as needed | Remove
influential point | re-fit model




> Resnonse Price
Regression Reports b

Estimates b

Slealieizaiy ' ‘irror tRatio Prob:= |t]

y 6733 167 01043

—

Factor Profiling

Row Diagnostics

—

v ov_P
¥ Plot Residual by Predicted

save Loldmns

Model Dialzog

Cnt Plot Residual by Row

Actual by Predicted Plot
700

600

500

Price Actual

100 200 300 400 500 600 700
Price Predicted P<.0001 RSq=0.81 RMSE=64.969
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Q Plot Actual by PredicteD

i S

L =linear

| = independent

E = equal variance

N = normally distributed errors

Residual by Predicted Plot
200

150
100

50

Price Residual

200 300 400
Price Predicted

We use

' to look for
patterns and want to
see values scattered
randomly about zero
and
‘ 'to
look for “leverage” for
the whole model — points
on the extremes and
outside the confidence
intervals are more likely
to have larger
conftributions to the sum
of squares




' To obtain “studentized residols”

(- ResBpnse Price | Studentized

E?rESSIDn Reports ' Studentized Cook'sD resid U O |S O re
= Estimates b Resid Price  Influence...
FEEIEEITT » lrror tRatio Probst] e saved to the
Factor Profiling » BI33 167 01043 ' '
0755 065 05191 “0.09731404 - 0.0000874884 data table
Row Diagnostics ¥ bear  n1 a4 07680221538  0.0213680011

0.9451784813
3.2456067936

0.0152031926
(0.6645816365

Save Cu:-lumns) 3 Prediction Formula

Predicted Values

L7

Madel Dialog
Script QT Residuals > We look at these by first Analyze > Distribution
PTETTECT TESTS Mean Confidence Interval == Distribution - JMP Pro -
4 Residual by Predicted PI Indiv Confidence Interval The distribution of values in each column
200 Studentized Residuals Select Celumns elected Columns into Roles
Hats > 12 Columns . Columns/| | 4 Studentize...esid Price
150 _ i alprice =S —
Std Error of Predicted dlBeds | Cancel |
E 100 Std Error of Residual B aths
2 s Feet EEE— —_—
Z 50 . Stdl Error of Individual areFee [ Weight | (Remove)
E * Effect Leverage Pairs alMiles to Base |  Freq | | Recall |
o 1 .- i cres — Help.
. Cook's D Influence A | By | | Help |
ars S e
il ears Old
Dol
il
alCook's D Influence Price
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4= Distributions

4= Studentized Resid Price

pericd.
4= Distributions

A | Studentized Resid Price
Display Opticns

Histogram Cptions
v Mormal Quantile Plot
v Outlier Box Plot

Quantile Box Plot

RSN

L =linear

| = independent

E = equal variance

N = normally distributed errors
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) — e

Studentized Resid Price

-1.64 -1.28 -0.67 0.0 0.67 1.28 164

0.02 0.05 0.12 0.3 04506 075 09 096

Normal Quantile Plot

We use to
check for normally distributed errors




Response Y

@0
W)
S
o
7}
]
c

I
20

Fitted values
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Response log(Y)

Residuals

I I I [ I
2.6 2.8 3.0 3.2 3.4

Fitted values

Figure 3.11 ISLR




Graph Builder

45
40
35
30

mpg

25
20
15
10
3.8

36

34
3.2
3.0

Log[mpg]

28
2.6
24
2.2

1500

Log[mpg] & mpg vs. weight

ot et
° ’. L °®
O: ?..;.‘.... l‘. .
;“ ~d ..’: ® e
it X :
% e :ri oo L,"..: ..' . . L]
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5000

mpg
— Smooth(mpg)
* Log[mpg]
Smooth(Log[mpg])




State modeling objective

Data gathering and preparation

Data exploration

Model

Check assumptions and conditions:
independence, equal variance, normal

Multiple Regression Modeling Process

Explore univariate | bivariate | multivariate relationships
for data quality and to inform understanding

* Transform y | Re-form model

Fit Model (guadratic, interaction terms,)

Residual v. predicted; actual v. predicted: ** |Jse stepwise as needed | Remove
studentized residuals; normal plot; influential point | re-fit model

Check high influence points, outliers
and multicollinearity

Cook's D; VIF
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. Collinearit

| from other predictors

We can use the

| Parameter Estimates

Term
Intercept
Beds

Baths

Square Feet
Miles to Resort
Miles to Base
Acres

Cars

Years Old
DoM

Effect Tests

Estimate 5td Error tRatio Prob:|t]

179.45965
9.7668087
53.275621
0.0445899
-1.698122
-1.878459
46547176
6.3837972
-0.273392
0.0324497

51.25743

159136
2065062
0.026733

260755
2632587
1.782149
1267613
0.547926
0133851

| Residual by Predicted Plot

3.50

0.0013*
able Style
Columns
Sort by Columng?
0 Uata Table
Make Combined Data Table
Make Into Matrix

Copy Column
Copy Table

Bootstrap

Multiple Regression | Jim Grayson, PhD

y: when a pric’ror can be predicted well

(VIF) to help identify collinearity in the model’s predictors

Term
~Bias
Estimate
Std Error

t Ratio
Prob:|t|
Lower 95%

Upper 35%

Design Stgdrror

Parameter Estimates

Term
Intercept
Beds
Baths

Square Feet
Miles to Resort
Miles to Base

Acres
Cars
Years Old
DoM

Estimate
179.45965
9.7668087
53.275621
0.0445899
-1.698122
-1.878499
4.6547176
6.3837972
-0.273392
0.0324497

Std Error tRatio

51.25743

15.9136
20.65062
0.026733

2.60755
2.632587
1.782149
12.67613
0.547926
0.133651

3.50
0.61
2.58
1.67
-0.65
-0.71
2.61
0.50
-0.50
0.24

Prob>|t|
0.0013*
0.5434
0.0142*
0.1043
0.5191
0.4802
0.0132*
0.6177
0.6209
0.8096

3.5544519
4.3822145
34757465
13.822325
14.510754
1.5212784

1.7883544
.2901804
10\5627487




Scatterplot Matrix

500 . __-.c. sg & ‘™ | N . - . } Wt e
Y APY L VR7 VAE RN PN W M SR :

e 588 00 .', ' ] ....00 0', -0 r. ! : -./ Ou = :.: When We eXOmIne .I-he
X Yt S-SR DAl scatterplot matrix we
T N O R  sce a sfrong
S YOA TV ERPY "VARE TON ST TR ON BUA- TR AR .

Nl il Rl b M- =30l  (5sOCiCfion between
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\ o
.
b

7

[
e

., .
20 S MY g0 | oype—
/ 2 | LYV ./

3-8

iy ;. l‘

40 010 30 0123

Years Old

*

_...

20 50

Parameter Estimates

Term
Intercept
Beds
Baths

Square Feet
Miles to Base

Acres
Cars
Years Old
DoM

Estimate Std Error t Ratio

181.44396
11.370069
50.724242
0.0430186
-3.493138
4.3625859
54694553
-0.192613
0.0592831

50.75587
15.59576
20.11275
0.026411
0.877935
1.710918
12.496906
0.529416

0.12612

3.57
0.73
2.52
1.63
-3.98
2.55
0.44
-0.36
047

Prob>|t|
0.0010*
0.4707
0.0162*
0.1121
0.0003*
0.0152*
0.6642
0.7181
0.6412

3.4693829
4.224488
3.4474345
1.6400357
1.4248944
1.766415




Points that fall horizontally away from the center of the cloud tend to pull harder
on the line, so we call them points with high leverage.

Points that fall horizontally far from the line are points of high leverage: these points
can strongly influence the slope of the least squares line. If one of these high leverage
points does appear to actually invoke its influence on the slope of the line — as in cases (3),
(4), and (5) of Example 7.23 — then we call it an influential point. Usually we can say
a point is influential if, had we fitted the line without it, the influential point would have
been unusually far from the least squares line.

It is tempting fo remove outliers. Don't do this without a very good reason. Models
that ignore exceptional (and interesting) cases often perform poorly. For instance, if a
financial firm ignored the largest market swings — the “outliers” — they would soon go
bankrupt by making poorly thought-out investments.

If there are outliers in the data, they should not be removed or ignored without
a good reason. Whatever final model is fit to the data would not be very helpful if
it ignores the most exceptional cases.

Be cautious aboul using a categorical predictor when one of the levels has very few

observations. When this happens, those few observations become influential points.

Chapter 7, Infroduction to Linear Regression, Openlintro.org
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Cook's D Influence Price

ose the Cook’s D measure 1o help identify > <>

25
< [~ Resnonse Price

Regression Reports I 2

Estimates

Studentized Cook's D 1.5

.Error t Ratio Prob>|t] Resi .
esid Pricg
Factor Profiling y B733 167 01043

0755  -0.65 05191 0.0009972419
PoRT -0.71 0.4807

I\Sa\re Columns ) Prediction Formula 00053877339

Effect Screening 3
Influence...

Row Diagnostics 3

Predicted Values L \ 00000574584
Script Residuals . E  0.0213680011

FTETTECT TESTS Mean Confidence Interval . 0.0152031926
A Residual by Predicted PI Indiv Confidence Interval 3.24560607936 \ 0.606045816305 Quantiles

200 Studentized Residuals 1O00%: ‘maximism: 34B077
Lot 99.5% 3.48077

150 97.5% 3.05834
Std Error of Predicted 90.0% 0.09425

100 Std Error of Residual 75.0% quartile 0.02756
50.0% median 0.01107
25.0% quartile 0.00193
10.0% 0.00015
Cook's D Influence 2.5% 6.91e-6
0.5% 1.38e-6

0.0%  minimum 1.38e-6

" Model Dialog

50 Std Error of Individual

Effect Leverage Pairs

Price Residual

Summary Statistics

Mean 0.1134296
Std Dev 0.5238164
Std Err Mean 0.0780859
Upper 95% Mea  0.2708015
Lower 95% Mean -0.043942

N 45
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Cook's D Influence Price
35 ]

39
25

2
15

17

0.5

0

0.5

Quantiles

100.0% maximum 348077
99.5% 3.48077
97.5% 3.05834
90.0% 0.09425
75.0% quartile 0.02756
50.0% median 0.01107
25.0% quartile 0.00193

10.0% 0.00015
2.5% 6.91e-6
0.5% 1.38e-6

0.0%  minimum 1.38e-6

Summary Statistics

Mean 0.1134296
Std Dev 0.5238164
Std Err Mean 0.0780859

Upper 95% Mea  0.2708015
Lower 95% Mean -0.043942
N 45

VIUITTIIC cUlC wj

We “select” the data point at the top (about 3.48)
and that is associated with row 7.

When we examine row 7 we see the house is a ranch
(40 acres) and therefore should be excluded from our
analysis. We select “rows > hide and exclude” and
rerun the analysis. Cook’s D is now in an acceptable
range.

Qyson, PhD
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INTERPRET RESULTS (STATISTICALLY VALID)

Relationship between response and predictorse




State and test hypotheses about
multiple regression coefficients

Analysis of variance; parameter estimate;
Model reduction (stepwise; manual)

Interpret regression statistics - whole
model results: adj R*2, overall p-value;
RMSE

Interpret signs of regression
coefficients

Assess usefulness of model (s,,
prediction intervals; profiler; variable
importance)

Apply to stated model objective

Multiple Regression | Jim Grayson, PhD




Summary of Fit

" RSquare 0.809043

________ RSquare Ad 0.759939 M
Root Mean Square Error 64.96897 F I -l-

Mean of Response 391.1911
Observations (or Sum Wgts) /

Analysis of Variance HypOTh eses

Sum of

Source Squares Mean Square F Ratio . oo

Model 625914.08 695460 164763 ( M d | S g f )
Error 35 14773384 42210 Prob > F O e I n I I C Q n C e
C. Total 44 77364792 <.0001*

Parameter Estimates
Term Estimate Std Error tRatio Prob>|t|

L]
Intercept 179.45965 51.25743 3.50 0.0013* D eTO I |S

Beds 97668087 159136 061 0.5434
Baths 53275621 2065062 258 0.0142* : M 1E3

Square Feet  0.0445899 0.026733  1.67 0.1043 (v O I’I O b | e S | g ﬂ Ifl C O ﬂ C e )
Miles to Resort -1.698122  2.60755 -0.65 0.5191

Miles to Base  -1.878499 2632587 -0.71 0.4802

Acres 46547176 1782149 261 0.0132*

Cars 6.3837972 1267613 050 0.6177

Years Old -0.273392 0.547926 -0.50 0.6209
DoM 0.0324497 0.133651 0.24 0.8096
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Summary of Fit

| RSquare

RSquare Adj
Root Mean Square Error 91143

Mean of Response 394.8545
Observations (or Sum Wgts) 44

Analysis of Variance

Sum of
Source DF Squares Mean Square
Model 8 64154054 801926

Error 35 10553429 30153 P

C. Total 43 747074.83

Parameter Estimates

Term Estimate Std Error tRatio
Intercept 173.94428 43.29045
Beds 9.1754331 13.30058
Baths 58.081524 17.24473
Square Feet  0.0376742 0.022546
Miles to Base -2.852459 0.766609
Acres 12.449926 2.570654
Cars 6.1533383 10.64938
Years Old -0.205754 0.451095
DoM -0.031255 0.110042
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F Ratio
26.5955

Prob>|t|

0.0003*
0.4948
0.0019*
0.1036
0.0007*
<.0001*
0.5671
0.6511

"'"Ia\}\odel Fit: RSquare Adj about 83%;

g

RMSE = 54.9

Null Hypothesis b, =b, =b; = ... =b,=0
Alternate Hypothesis: Atleast one b #0

Decision: Reject Ho and Accept Ha (at
least one b # 0 ) with pvalue < .0001

Given that all variables are in the model we
notice that Baths, Miles to Base, Acres are
significant.

We will undertake an iterative process of
eliminating one variable at a time, re-
examining the p-values and then eliminating
the next variable with a p-value > 0.10




Summary of Fit
RSquare
RSquare Adj
Square Error :
onse 394.8545
(or Sum Wgts)

Analysis of Variance

Sum of

Source DF Squares Mean Square F Ratio
Model 4  638004.83 159501 57.0326

Error 39 10 00
C. Total 43 747074.83

Parameter Estimates

Term

Intercept

Baths

Square Feet
Miles to Base -
Acres 1

Residual by Predicted Plot

o
S
‘in
@
o
L]
o
‘=
o

200 300 400 500 600
Price Predicted
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3192172

1.0187721

700

The results of our iterative process:

Nofice that p-values are less than 0.02,
Rsquare Adjis about 84%, VIFs are low
and residual by predicted looks better
that before.
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INTERPRET RESULTS (USEFULNESS)




State and test hypotheses about
multiple regression coefficients

Interpret regression statistics - whole
model results: adj R*2, overall p-value;
RMSE

Interpret signs of regression
coefficients

Analysis of variance; parameter estimate;
Model reduction (stepwise; manual)

Assess usefulness of model (s,
prediction intervals; profiler; variable
importance)

Apply to stated model objective
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Sy ——— The Rsquare / Rsquare Adj gives us a
RSquare 0.854004 S

RSquiare Adj measure of the variability in the data
kOIS SRIB ceE . 7B eEny explained with our model. Larger values

Mean of Response 394.8545

Observations (or Sum Wats) 44 are prefe rred .

The Root Mean Square Error tells us the
ve Columns 3 Prediction Formula . .
Edemimg Predicted Values standard deviation of the error (¢) — a
i Restduak measure of variability of the model.

Mean Confidence Interval

Indiv Confidence Interval

Summary of Fit

¢
Riquare 04 Studentized Residuals
RSquare Adj a0

Root Mean Square Error

Mean of Response 39 Std Error of Predicted These “que COlumnS” Gre Gdded TO The

52 Hats

Observations (or Sum Wgts) Std Error of Residual

Analysis of Variance Std Error of Individual DOTG TO ble COl umns

Sum of
Source DF  Squares

Model 4 63800483 Cook's D Influence N
Errar 30 100070.00 Pred Formula Predicted Lower 95%  Upper 93% Lower93%  Upper 93%

. Total 43 74707483 StdErr Pred Formula Price Price Mean Price  Mean Price  Indiv Price  Indiv Price
Parameter Estimates Mean Confidence Limit Formula 32883406706 32883406706 309797172 34787096213 2201862594 43748187472

Estimate Std E ndiv Confidence Limit Formula 35016836166 35916836166 327.26202573 391.07469758 247.54418413 47079253918
17546632 301 Save Coding Table 4046893553 4045893553 38547911534 423.80959526 296.01104074 513.36766086

Effect Leverage Pairs

Multiple Regression | Jim Grayson, PhD




Select the "parameter” table and right click >

Select Columns >
Select Lower 95% and Upper 95%

Table Style
Columns
Sort by Column..,

Make into Data Table
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Term

~Bias
Estimate
Std Error

t Ratic
Prob:=[t|
Lower 95%
Upper 95%
Std Beta
VIF

Design Std Error

Parameter Estimates

Term Estimate Std Error tRatio Prob:>|t|
Intercept 17546632 30.1538 582 <.0001*
Baths 63.61719 14.57999 436 <.0001*
Square Feet  0.0472992 0.019337 245 0.0191*
Miles to Base -3.025002 0.694498 -4.36 <.0001*
Acres 12462947 2.237932 5.57 <.0001*

Lower 95%
114.47449
34.126385
0.0081874
-4.429757
7.9363021

Upper 95%
23645814
93.107996

0.086411
-1.620247
16.989592
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HOW TO APPLY THE RESULTS

Prediction




175.466319174148 + 63.6171900658549 * :Baths +
0.0472992279684479 * .Square Feet +
-3.02500213727099 * :Miles to Base + 12.4629468282909 * :Acres

For a 2 Bath, 3000 SF, 2 Miles to Base, 1 Acres

Pred Formula Predicted Lower 95%  Upper93% Lower93%  Upper 95%
Price Price Mean Price Mean Price Indiv Price Indiv Price

451.01132576 = 391.76403471 510.25861682 328.73220149 575.29045004

Predicted Price +/- Confidence Intervals for the Mean and Individual Prediction Intervals

Multiple Regression | Jim Grayson, PhD




Multiple Regression | Jim Grayson, PhD 49

MANAGERIAL IMPLICATIONS

Insights: Profiler; Variable Importance; Confidence and Prediction Intervals




Confidence Intervals and Prediction Intervals can be
examined to deftermine the usefulness of the prediction
—is the model useful taking info account the variability
in the intervals

Lower 95% Upper95% Lower95% Upper 95%
Mean Price = Mean Price Indiv Price Indiv Price

391.76403471 510.25861682 328.73220149 573.29045004
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.| *IResnonse Price
Regressicn Reports

Estimates

Effect Screening ror tRatio Prob:zItl Lower 95% Uoppe
Factor Profiling v  Profiler

X
The Profiler allows an

interactive interface to vary
Prediction Profiler the value of predic’ror(s)
700 5 1 5 and observe the impact on

. Np— 600
394.8578 5o

i ARSI Il N | hc response (Price) and
~ 4109837 3007 i : 5, the impact of changing
100 ’ | : one predictor on the other
g predictors. The profiler can
help build understanding
and intuition about the
relationship of the
predictors to explaining the
response variable.
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Variable Importance: Independent Uniform Inputs

Summary Report

Main Effect Total Effect .2 4 !
021 0211 |
0.157 0.157 |

faWaT~le] Nnncgll

oTee =awi= |

Square Feet 0.065
Marginal Model Plots
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This tool shows the relative
Importance of the predictor
variables, first in relative impact
— that is, which variables with @
+/- change in value will have
the largest impact on the
response (think of this as a
sensitivity analysis) and then
secondly, the marginal model
plots provide insight into the
main effect of the variables




